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contemporary cartography 
and mapmaking

Bonus Material
On the pages that follow, you’ll find expanded instructions for the  

step-by-step projects on pages 46-83 in your book. 
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Lake Garda
Lake Garda is the largest lake in Italy. What 

fascinated me most about my trip here was 

the ferries that skirted around the towns and 

villages on the water’s edge. I wanted this 

map to be about them—these little towns and 

the routes the boats take, which link all these 

places together.

(Opposite) Next I sketch the POI’s. 
I do a lot of image research at this 
stage and look for pictures I like 
that show the subject at the right 
type of perspective. I draw from 
these, often distorting the angle and 
simplifying the subject as much as I 
can without losing too much detail. 
When working digitally, I scan all 
the drawings into the computer and 
clean them up a bit. 

Tip
I sometimes draw 
the outline of the 
country or place 
freehand, but I 

usually trace a digital 
screenshot for two 

reasons: (1) it saves a 
lot of time, and (2) it 

ensures accuracy.

I roughly trace around the outline of the area, 
and number the spots where I want to illustrate 
something interesting. The numbers refer to a list of 
potential points of interest (POI’s) I thought would 
make good illustrations. There were many things I 
wanted to cram into the map, but I had to remain 
selective and choose what works compositionally. 
Next I add other important details, leaving space 
for traditional map elements like a compass and a 
title. To finish my rough sketch, I add topographical 
markers to flesh out empty areas of the map. I try 
to stick to the real topographical features of the 
landscape whenever possible. 
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I separate the POI’s in Photoshop on separate layers on top of my earlier plan. As you can 
see, I rotated, flipped, or erased sections of my drawings to make them fit.

Tip
When working 
digitally with 

layers, set the layer 
transparency to 

“Multiply,” so you 
can see through the 
white of the paper. 
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I prefer to add color in Illustrator, 
rather than Photoshop. Illustrator 
uses vectors, so you can adjust 
the size many times and to any 
scale without losing quality. You 
can also create lots of shapes in 
the same layer so the file sizes are 
much smaller and faster. I export 
the Photoshop layers to Illustrator 
separately, as JPEGs. First I work 
on the background, using the 
map screenshot. I use the pen 
tool to trace around the lake and 
the brush tool, with the pressure 
sensitivity turned on, to create 
thick and thin bends in the river. In 
the top left, you can see my color 
palette.

Next I bring in the Photoshop layer 
with my POI’s and place the image 
on its own layer, set to “Multiply,” 
above the rest of the artwork, so 
I can flick the layer’s visibility on 
and off to see how the work is 
taking shape.

I create a new layer above the green one for white objects. I don’t 
want to subtract anything at this stage, to ensure the freedom to 
move and scale objects around freely. Then I use the pen tool to 
trace around my first POI, one of the ferries. I repeat this process, 
creating a separate layer for the different colors, altering the 
opacity of the shapes to “Multiply” to replicate an overprint 
effect similar to screen printing. I love the look of that traditional 
technique. I also deliberately overlap and offset some of the layers 
slightly to give the artwork a slightly mis-registered appearance.
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(Opposite) I decide to change the 
background to yellow and reverse the 
lakes and rivers to white. I also make 
some adjustments to all the POI’s to 
account for the new background. As 
mentioned before, I don’t subtract 
anything at this stage, so I cheat a 
little bit with additional layers that I 
will remove later when I bring it back 
into Photoshop.

For POI’s that are yellow, such as the 
lemons or the Oscar statue, I create 
white “cutout” shapes around the 
illustration to keep the object from 
merging into the background.

Finally, I bring in the topography layer 
from my Photoshop sketch to begin 
adding the trees, mountains, railways, 
and a compass. These little elements 
fill out any empty space and go a long 
way in making the illustration start to 
look like a map.

I repeat this process for the Grand Hotel, another four POI’s, and two ducks. On looser shapes, 
such as the chocolate sauce in the milkshake glass, I like to use the pencil tool instead of the 
pen tool, because it’s faster. Imprecise shapes require a lot more anchor points than a regular 
shape. With the pencil tool you can draw the whole shape in almost one motion. There are many 
settings you can adjust to alter how closely the shape you create matches the original line. 
Again, it’s a balance of smoothness over accuracy. 

The pen tool allows you to outline and fill shapes very quickly, but 
it creates very clean and precise edges. My style aims to emulate 
a handmade technique, so I like to add a “Roughen” filter to the 
objects. Experiment with the different settings to find your preferred 
balance of detail vs. roughness. See page 44 in your book for more 
tips on using this effect.
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Start by making a small, straight section of black track using the pen tool. Then create a new pattern brush using this shape by clicking 
the “New Brush” icon at the bottom of the brush panel and choosing “New Art Brush” in the pop-up window.

Making a Pattern Brush for the Railroad
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There are lots of settings you can explore. I chose the approximate path setting, which retains the original artwork without distorting 
the shape. I set the spacing to zero, so there aren’t any gaps, and I set the colorization method to “tints.” Because the pattern is black, 
checking the tints box allows you to alter the color of the brush just by changing the stroke color. If you had specified the color to begin 
with, you would need to create a new brush every time you want to change the color of the track.
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Next I simply draw a colored line 
with the pen tool (above left) and 
change the “Stroke Style” to the 
pattern brush I made (bottom 
left). Voilà! 

I start with the railway. To make 
the track, I use a simple Illustrator 
trick that saves a lot of time and 
effort.

See the previous page for the 
instructions, and see page 44 
in your book for more tips on 
creating your own custom brush.

(Opposite) Next I add place names, 
trees, and mountains. You can 
individually hand letter each bit of 
type, but to save time I digitized a 
few of my own custom typefaces 
to use in my maps. There are many 
different font-making programs, 
ranging in price. I use a website 
called www.calligraphr.com, which 
isn’t perfect, but it’s free and does 
a great job.
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Once finished in 
Illustrator, I start 
moving things back 
to Photoshop, moving 
the objects grouped by 
color. I start with the 
solid yellow background. 
I bring in my “cheat” 
white layer and subtract 
it from the yellow. Then 
I bring in the greens, 
setting the layer style to 
“Multiply” again to get 
that nice overprinted 
effect. 

(Opposite) Next I bring 
over the peach layer. 
Finally, I bring in the 
last layer—the brown 
color that results from 
combining the green 
and peach. I set this 
as a solid layer (no 
multiply). I mainly 
do this for line work 
or text that I want to 
be clear and legible, 
without any misprinted 
edges. Now all the 
artwork is separated 
over only four fixed 
layers. I like this stage, 
when everything 
gets subtracted and 
condensed. It always 
amazes me how much 
you can achieve with 
so few colors! 
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(Opposite) To finish, I add some intricate freehand line work 
and hand lettering, which is more difficult to produce in 
Illustrator due to its tendency to smooth out the lines. I use 
a great Photoshop brush set to add stippled, shaded, and 
textured lines. With these final touches, my map of Lake 
Garda and its ferries is complete!

I begin texturizing the artwork with some of my own custom brushes. I created these using a mixture of paint splashes, some of which I scanned 
in and some that I downloaded from the Internet. I needed to give the splashes a screen-printed aesthetic. To do so, I used Photoshop’s “Color 
Halftone” filter, setting all the channels to zero with a max radius of about eight pixels. This creates a pixelated effect that makes it look like the 
ink splash passed through a silk screen. Shown above is an example of this effect.

I then crudely select the shape using the lasso tool, and 
define the area as a new brush preset. To make sure that 
the dots aren’t too close together, I make the paint splash a 
mid-gray. The lighter the color, the less densely the halftone 
pixels will be packed. Next I use these new brushes on each 
of my four layers, sometimes as erasers creating under-
inked dry patches, and the rest of time as brushes creating 
artificial splashes of misprinted ink. In this close-up you can 
see the subtle texture of the map.

Tip
There are many online 
sources for free grungy 

textures you can 
download. A couple of 
my favorites are www.
blog.spoongraphics.

co.uk and www.
lostandtaken.com.
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I drew inspiration for this map from a 300-mile 
bike ride down the west coast of France, which I 
completed with my best friend.

I use a screenshot of a section of a digital 
map as a guide to plot the cycle route.

I open the screenshot in Photoshop and 
roughly trace over the map, drawing around 
the coast, picking out a few main roads, and 
drawing the route. I also indicate where I 
want to draw a compass and the direction of 
north. (Notice I rotated the map slightly so 
the route would be at a straighter angle.)

Next I place a topographical survey of the 
region underneath my sketch. Using the 
image, I can see where the mountainous 
regions are and add markers to my map for 
mountains and trees. 

French Bike Ride
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On the side of my 
sketch, I include an 
illustrated itinerary 
of what I took with 
me. I thought it would 
be fun to draw some 
of the stuff I lugged 
around on the back 
of my bike for 300 
miles. I sketched 
almost everything 
in my sketchbook, 
scanned them in 
to my computer, 
and arranged the 
drawings. It took 
some maneuvering, 
and the scales of 
the items aren’t 
consistent, but that’s 
okay. Don’t be afraid 
to try something new 
in your mapmaking—
you may surprise 
yourself!
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Using Image Trace to Create the Mountains

Create a triangle and fill it with a gradient. I set the angle to 90 degrees so the black descends from the top of the mountain. Altering the 
“location” changes how strong and far either end of the gradient extends. I wanted the back to extend further, so I move this closer to the 
white end of the scale. 

On the top menu bar, click on Effects > Texture > Grain. Using the filter, with the grain type set to stippled, alter the intensity and contrast 
settings until you’re happy with the result. 
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Next expand the appearance of the shape. Now you can use the image trace tool to revectorize the object. There are many different 
settings you can adjust in the trace toolbar. I want to capture the grittiness of the effect without needing to capture every little speck. 
“Threshold” determines the overall detail of the trace, “Paths” alters how tightly it traces, “Corners” adds more anchor points, and “Noise” 
filters how much of the small details the trace picks up. It’s a balancing act to find the settings you like, but once you’ve found the right 
combination you can save the preset and use it instantly whenever you want to trace something in a similar way. Be sure to tick the 
“Ignore White” box so that it creates a single-color shape after the trace. 

Expand the object once more, and now you can alter the color and size, and add as many mountain peaks to the map as you like. 
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Using the Star Tool to Create the Compass

I create the cog-shaped background of the compass using the star shape tool. I wanted a large cog, so I set the points to 32 and alter the 
radii so that radius one is almost half of radius two. The first radius refers to the inner angles of the star, while radius two refers to the 
outer radius of the star tips. 

Here is the star shape that results with these settings. 
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It was important to set the difference between the two radii so large, because I can use Illustrator’s round edges feature (active when 
using the direct selection tool), and the greater difference allows me to round the edges until curved and resembling a cog wheel.

For the middle of the compass, you can simply use two triangle shapes with a small circle in the middle.



Next I add trees and a compass to 
the map. I created the cog-shaped 
background of the compass using 
the star shape tool. (See the 
previous page.)

(Opposite) Next I bring in the JPEG 
containing my inventory and draw 
around all the items using the pen 
tool. I had to think creatively with 
some of the objects—restricting 
yourself to only a few colors 
presents challenges, which is why 
I often draw things as simply and 
clearly as possible. Since I wasn’t 
trying to replicate a screen-printed 
aesthetic, I kept all the items on 
the same layer, which made things 
much simpler. 
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After finishing the inventory items, I begin drawing the 
POI’s, starting with the mechanical elephant I saw in 
Nantes. This creature is made up of multiple panels, 
so I thought the simplest way to represent that was to 
break it into parts with small gaps between each of the 
sections. Rather than trying to draw the same exact 
curves on either side of the gap, I cheated and used 
Illustrator’s “Offset Path” setting. See page 45 in your 
book for more tips on using this tool.

First I draw two shapes overlapping one another. I select 
the shape with the curve I want to use and apply the 
“Offset Path” setting with only a small value entered. 
(The larger the value, the bigger the resulting offset.) I 
subtract the resulting shape from the adjacent panel, 
creating a curve that matches the adjacent one. I 
repeated this process until I make the entire body. 

To make the fairground, I use a few 
techniques that I haven’t mentioned yet. 
See the following page for a full tutorial 
on how to use these new techniques to 
make the different fairground pieces.



Tip
Holding the alt key 

while using the 
rotate tool allows 
you to move the 
rotation point to 
wherever your 

cursor is pointing. 
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Creating the Fairground

For the Ferris wheel, I use the rotate tool to quickly duplicate elements. If you double-click the rotate tool, 
a new tab opens that allows you to specify the rotation amount. Pressing copy rotates and copies the 
original shape, and by pressing ctrl + d afterwards you can repeat the action as many times as you like. 

To make the wavy shape on the food and balloon stands, I start by making a straight line. Then I apply Illustrator’s Zig Zag effect, found 
under the Distort & Transform tab.  
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The size bar alters the strength of the effect, and the “Ridges” setting determines the number of ripples. I tick the smooth box 
to create rounded waves. 

I expand the effect and use the pen tool to complete the shape. Once you’ve done this, all you have to do is turn off the stroke color and 
select whatever fill color you like!
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This map is based on 
a recent adventure to 
Indonesia. We traveled 
around the east of Bali and 
across to the Gili Islands 
for a few weeks.

For reference, I took a screenshot of the area I wanted to 
draw. I took some creative liberties by moving and adjusting 
the size of some of the islands to fit everything I wanted 
and leave room for a compass in the bottom right corner. 
Illustrated maps don’t always have to be completely 
accurate—the map is more like a journal, rather than 
something to navigate by. 

I trace the islands in Photoshop and add towns, a rough 
compass, and markers for the points of interest (POI’s). I also 
draw a box around the Gili Islands to indicate that they are 
added to the map from an area just outside its boundary. This 
is a common trick in cartography—for instance, take a look at 
a map of the United Kingdom, which commonly features the 
Shetland Islands in this way.

Bali
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Next I sketch the POI’s 
in my sketchbook and 
scan them. After a bit of 
cleaning up in Photoshop, 
I bring each image into 
the document, setting 
the opacity to “Multiply,” 
and arranging them on 
the map. Bali has a rich 
cultural heritage, and I 
wanted to reflect that in 
the compass design and 
the traditional Balinese 
mask. I also add the boat 
route that took us to the 
Gili Islands and to Kuta.

I add trees, mountains, 
and waves. I usually draw 
these items quite small 
and scatter lots of them 
around the map, but 
this time I made these 
elements larger. The 
tropical terrain is a big 
feature of the island, and I 
want to emphasize that. I 
also add text for the POI’s 
and towns.
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Bali is rooted in traditional 
art and beliefs, so I want 
to create a hand-drawn 
aesthetic for this map. To 
do so, I use a lightbox and 
layout paper to draw over 
my original sketch. However, 
rather than tracing every 
single line, I picked out areas 
of shadow with rough pencil 
strokes and some edges to 
add definition.

I bring the first of my sketch 
layers into Illustrator and use 
the pen tool to draw around the 
islands and create the small box 
around the Gili Islands. 

Then I scan the layout paper 
and clean it up in Photoshop. 
I open the clean scan in 
Illustrator and use the “Image 
Trace” tool to vectorize the 
lines, with a high threshold 
and path setting to capture 
most of the detail. Some 
lines are broken and slightly 
distorted, which adds to 
the roughened, handmade 
appearance I want.
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Tip
Hold the shift key 
down while using 

the pen tool to lock 
into drawing straight 

lines or 45-degree 
angles.
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Creating the Palm Trees

To make the trees, I draw around my pencil outlines with the pen tool.

Next I apply the roughen filter to slightly distress the edges. 
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Then I paste the image-traced lines into the document and alter the color and line up the new shapes with the trees. 

I set the opacity to multiply to make the shapes darker and create an overprint effect. Now I can copy and paste as many trees as I like 
for the map.
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Next I add several sets of trees to the map.

I bring in the image containing my POI’s and 
line it up with the map, setting the opacity 
to “Multiply” on a locked layer above the 
artwork so I can work underneath the line 
sketch without accidentally moving it.

Next I start the process of adding color to 
the POI’s, beginning with the sea turtle. I 
start this process very similar to how I made 
the trees. I block in the colors with the pen 
tool, using the sketch as a guide. Then I 
place the image-traced lines on top of the 
shapes and set its opacity to “Multiply.” 
The lines were too heavily broken up on the 
turtle’s shell, so I use the brush tool with the 
pressure sensitivity turned on to fill in the 
missing lines. Then I expand the lines, group 
them together (Object > Group), and set the 
opacity to “Multiply.” I apply the “Roughen” 
filter to the colored shapes and create a 
white area for the eye.

The most challenging part was creating the 
pattern on the shell. Illustrator has a great 
“Zig Zag” tool, which I used on a series of 
lines that mirrored the contours of the shell.
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I continue creating the rest of the POI’s in a 
similar fashion, one at a time. 

To fade the water in the temple pool into the 
background. 
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Creating the Faded Water Effect

First I make an oval with a radial gradient, with the aspect ratio set to 30 degrees to make a much flatter curve. 

Then I use Illustrator’s grain tool (Effect > Texture > Grain) to create a stippled effect. 
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Next I use the image trace function to vectorize the new shape. 

Then I expand the shape (Object > Expand) and convert it into a compound path. 
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Using the pathfinder (Effect > Pathfinder) “minus front” tool, I remove a square shape that follows the base of the structure. 
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Then I move the stippled shape to the back of the artwork, and it’s finished!
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I bring in the mountains and 
waves, which I had image-
traced from my sketches—
just like I did for the POI 
shadows and outlines. Then I 
add all the text using my own 
custom fonts.

I decide to change the 
brown background to 
turquoise and add a light 
gray to the color palette. 
You can quickly change 
colors in Illustrator by 
going to the “Select” tab, 
navigating to “Same,” and 
choosing “Fill Color.” 

Tip
To choose colors 

that work well 
together, convert 

your palette to 
grayscale to ensure 

there is a good 
contrast between 

the different 
swatches. 
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See the following four pages to see how I add different textures to the individual layers.

Next I bring the Illustrator objects into 
Photoshop to add textures. I separate the 
objects into five groups/layers: (1) the sea, (2) 
the land, (3) the illustrations, (4) the image-
traced lines (set to “Multiply”), and (5) the text. 
This will allow me to create different textures 
on individual layers.

You can create your own inky texture by using 
printing ink, a roller, and your scanner. I use an 
inked texture from a pack that I purchased; 
the texture has a transparent background, so 
I simply paste the image into my Photoshop 
document (above) and use “Color Overlay” in 
the layer style to change the texture’s color to 
a slightly lighter green than the background 
(left).
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Adding Texture Backgrounds

Here I drop in the first texture into the Photoshop document.

Then I use the color overlay layer style to recolor the texture. I want a subtle effect over the sea, so I choose a color that’s slightly lighter 
than the green background. 
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Next I do the same for the land layer, but this time I click the land layer in the side tab while holding the ctrl key to select the entire 
shape. Then I create a layer mask using the selection to restrict the texture to only the land. 

I use the color overlay style and choose the same green color I used for the sea. 
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This texture is a bit too strong, so I use the eraser tool and a rough brush to reduce the strength of the effect around the POI’s. I also 
reduce the opacity to make the effect subtler. 

Next I do the same with the layer of POI’s, but this time I keep the texture its original color. 
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I also set the style to overlay with a reduced opacity value so that the effect is very subtle. 

There are a few areas where I want to increase the amount of texture, but I don’t want it to overspill into other POI’s. To overcome this, I 
use the lasso tool around the illustrations I want to include, and then I use a custom brush to add more texture to the area.
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